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Legal and General Information
Notice
Unauthorized reproduction of all or part of this guide is prohibited. The information in 
this guide is subject to change without notice.

Kyocera Mita cannot be held liable for any problems arising from the use of this product, 
regardless of the information herein.

Regarding Trademarks
KYOCERA and KYOCERA MITA are registered trademarks of Kyocera Corporation. 
Windows  and Windows Server are registered trademarks of Microsoft Corporation. 
Windows NT is a trademark of Microsoft Corporation. Adobe, Adobe Acrobat and 
Adobe Reader are registered trademarks of Adobe Systems Inc. Other brand and 
product names contained in this document are registered trademarks or trademarks of 
their respective companies.

General Information
When using this utility, the items that can be configured will be different depending on 
the printing system model.

Examples in this document are described using the Microsoft Windows XP operating 
system environment.

Precautions
KM-NET for Accounting can only obtain accounting data of the Kyocera printing system 
compatible with accounting functions. It cannot be used with any other third party 
printing system.

When using KM-NET for Accounting, ensure that the Kyocera printing system 
compatible with accounting functions is connected to the network (Ethernet).

KM-NET for Accounting is designed to run on Microsoft Windows 98SE/ME/2000/XP 
operating systems.

When using KM-NET for Accounting, ensure that the TCP/IP protocol is installed in the 
PC.

If you are already using a compatible Kyocera printing system, update of the firmware is 
required to use KM-NET for Accounting. Contact your service provider for details.
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1. What is KM-NET for Accounting?
1.1. What is KM-NET for Accounting?

KM-NET for Accounting is an application that assists in account management.

An account means a unit of the organization of the company, or individual roles in the 
entire business.  Account management means to manage the counters on the printing 
systems on an account basis.  Account management first requires account registration 
on each printing system.  The count is then recorded on each counter of the account.

The main features of KM-NET for Accounting are as follows:

Selectable Viewpoints
Accounting information can be displayed on a printing system basis or an account 
basis.

Folder Management
Accounting information is managed through logical folders, similar to Windows Explorer.

Speedy Access
Accounting information is stored in an MDB file for reducing frequent access to a 
printing system. This enables the user to instantly view accounting information that has 
already been obtained.

1.2. System Requirements

Item Description

OS Microsoft Windows 98SE
Microsoft Windows ME
Microsoft Windows 2000 Professional
Microsoft Windows XP Home Edition/Professional Edition

Protocol TCP/IP

Interface Ethernet (10BASE-T/100BASE-TX)

PrintersPrinters MFPMFP

Kyocera Extended Kyocera Extended 

DriverDriver

Client PC

KM-NET for AccountingKM-NET for Accounting

Administrator PC
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2. Accounting System Configuration
2.1. Basic Flow

Follow the steps below to configure the accounting system.

Step 1 Install KM-NET for Accounting. Refer to Installing the KM-NET for Accounting on 
page 5.

Step 2 Starting KM-NET for Accounting. Refer to Starting the KM-NET for Accounting on 
page 5.

Step 3 Register printing systems in KM-NET for Accounting. Refer to Registering the 
Printing System on page 6.

Step 4 Assign an account ID to the registered printing system. Refer to Assigning the 
Account ID on page 7.

Step 5 Enable the accounting function of the printing system. Refer to Enabling the 
Accounting Function on page 8.

Step 6 Register account ID to Kyocera Extended Driver of the client PC. Refer to 
Configuring the Kyocera Extended Driver on page 8.

System configuration is complete. Refer to each section in this document for details on 
operations and settings.
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2.2. Installing the KM-NET for Accounting

1 Double-click Setup.exe. The InstallShield Wizard starts.

2 Follow the instructions displayed on the window to install KM-NET for 
Accounting.

2.3. Starting the KM-NET for Accounting
When the installation is complete, you can start  KM-NET for Accounting by clicking 
the start menu > All Programs > Kyocera > KM-NET for Accounting.

Registering the passwords
When KM-NET for Accounting is launched for the first time, the KM-NET for 
Accounting Startup Wizard starts. Follow these steps to register the administrator and 
database passwords. The wizard does not re-appear once the passwords have been 
registered.

1 Register an administrator password. If an administrator is logged onto the domain, 
then a password is not required. Select the checkbox for Use Windows Domain 
authentication to login to KM-NET for Accounting without entering the 
administrator password.

2 Click Next.

3 Register a database password (recommended).

4 Click Finish.
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Login
When KM-NET for Accounting is launched, the authentication screen for the 
administrator password appears. Enter the password and click OK.

2.4. Registering the Printing System
After login, the Add Printing System Wizard starts. If you do not need to add printing 
systems here, click Cancel.

Discover printing systems
Searches and adds the printing systems.

1 Select Discover printing systems. Click Next.

2 Specify Community name and Timeout time.

3 Click Next. Searching of the printing systems starts.

4 After searching completes, the available printing systems are displayed.

5 Select the desired printing system and click Add to move it from the Discovered 
list to the Registered list. If you want to remove any of the systems from the 
Registered list, select the printing system and click Remove.

Notes
• The printing systems marked with  do not have a default accounting 

administrator code, administrator user ID or password. To register these printing 
systems, you must enter the accounting administrator code or the user ID/
password.

• If the printing system supports media size counter, select the checkbox for 
Obtain media size information to display the paper size in the media size 
counter.  If the checkbox is unchecked, the Configure Media Type cannot be 
specified for some of the printing systems.
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6 Click Finish. Registering of the printing systems starts.

7 After registration is complete, the selected printing systems are registered in this 
application.

Add printing system
Registers a printing system by specifying an IP address or a host name.

1 Select Add printing system. Click Next.

2 Specify IP address/Host name, Community name and Timeout time.

3 Click Add. The available printing systems are displayed. If you want to remove any 
of the printing systems, select the system and click Remove.

Notes
• If the printing system supports media size counter, select the checkbox for 

Obtain media size information to display the paper size in the media size 
counter.  If the checkbox is unchecked, the Configure Media Type cannot be 
specified for some of the printing systems.

• The printing systems may have their accounting administrator code, 
administrator user ID, or password modified from the default. If prompted, you 
must enter the accounting administrator code or the user ID/password to register 
these printing systems.

4 Click Finish. Registering of the printing system starts.

5 After registration is complete, the selected printing system is registered in this 
application.

Import printing systems
Imports printing systems from the selected file which is saved by export function in the 
File menu. For details, refer to Export on page 16.

1 Select Import printing systems. Click Next.

2 Specify the file name or click Browse to browse to the CSV file.

3 Click Finish. Registering of the printing systems starts.

4 After registration is complete, the printing systems are registered in this 
application.

2.5. Assigning the Account ID

1 Select the printing system from the printing system view to assign the account ID.

2 Select Add from the Account menu. The Add New Account dialog box appears.

3 Specify the Account ID and Account Name.

4 Click Add. The account ID is assigned to the printing system.

5 To assign another account ID, repeat steps 2 to 4.
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2.6. Enabling the Accounting Function

1 Select the printing system from the printing system view to enable the accounting 
function.

2 Select Property from the printing system menu. The Printing System Property 
dialog box appears.

3 Select the checkbox to Enable Job Accounting.

4 Select the checkbox for each function to apply the accounting function.

5 Click OK.

2.7. Configuring the Kyocera Extended Driver
Perform the following procedure to register the account ID to Kyocera Extended 
Driver.

1 Open the Printers and Faxes window from the Start menu.

2 Right-click on the printer icon and click Properties. The Properties dialog box of 
the printing system appears.

3 Select the Device Settings tab.

4 Click on Administrator. The Administrator Settings dialog box appears.

5 Select the checkbox for Job Accounting to enable the accounting function.

6 Select one of the usage patterns below, depending on your environment.

Use Specific Account ID
This will not prompt you to enter the account ID each time you print on the printing 
system. This is convenient if the PC is always used with the same account ID.

Prompt for Account ID
This prompts you to enter the account ID each time you print on the printing system. 
This is convenient if the PC is used with several account IDs. This does not check 
whether the entered account ID corresponds with the ID in the account ID list.

Prompt for Account ID and Validate
This is similar to Prompt for Account ID. This prompts you to enter the account ID 
each time you print on the printing system. If the entered account ID does not 
correspond with the ID in the account ID list, the job will be canceled. For details of 
account ID list, refer to Account ID List Configuration on page 9.
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Display Account ID List
This prompts you to select the account ID from the account ID list each time you print on 
the printing system. For details of account ID list, refer to Account ID List Configuration 
on page 9.

7 Click OK.

If you want to protect and restrict the settings in the Administrator Setting dialog box, 
refer to the Kyocera Extended Driver Operation Guide.

Account ID List Configuration
Perform the following procedure to register account IDs in the account ID list.

1 Click on the Account ID list on the Administrator Settings dialog box.

2 The Account ID List dialog box appears. Configure the account ID list.

Add
Adds an account ID to the list. Specify Account ID and Description. The maximum 
length of account ID is 8 digits. The maximum length of description is 31 characters.

Delete
Deletes an account ID from the list.

Edit
Edits the account ID and description.

Import
Imports account IDs to the list.

Export
Exports the account ID list to a file.

3 Click OK.
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3. Screen Layout
3.1. Printing System View

The main screen switches to printing system view when the Printing system tab is 
clicked.

Tree
Inside the printing system view, the tree displays the printing systems registered in this 
application.

All printing systems
Displays all registered printing systems.

My Folder
Displays the user-defined folder and link to the printing system. You can add, rename or 
delete a folder. The printing systems displayed here are links to one in All printing 
systems. If you delete a link in My Folder, the corresponding printing system in All 
printing systems is not deleted.

Note
If a printing system in All printing systems is deleted, the link to the corresponding 
printing system in My Folder is automatically deleted.

Main list
Displays the account ID relating to the printing system selected on the Tree. The Main 
list displays the account ID and items below.

Account ID Displays the account ID. Without Account ID displays 
the page count of the jobs without a specific account. 
Total displays the total page count of all account IDs. 
Life counter displays the life counter by function.

Account name The account name which is defined when the account 
ID is created.

Copy and Print (Total) The sum of Copy (Total) pages and Print (Total) 
pages.

Copy (Total) The total copied pages.

Print (Total) The total printed pages.

Copy (Full color) The count of copied pages in full color.

Print (Full color) The count of printed pages in full color.

FAX (Send) The page count of the faxes sent.

FAX (Receive) The page count of the faxes received.

Scan (Total) The total scanned pages.

Scan (Copy) The count of scanned pages for copying.

Scan (Other) The count of scanned pages other than copying.

Copy (Mono color) The count of copied pages in mono color.

FAX (Send time) Total time of FAX transmission.
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Sub list
Displays the page counter by function. When the connected printing system is a multi-
functional copier, function or media can be selected from the combo box on the upper 
right of the sub list.

List style

Graph style
The current page counter value is displayed in red and the maximum output/input value 
is displayed in blue.

3.2. Account View
The main screen switches to account view when the Account tab is clicked.

Tree
Inside the account view, the tree displays accounts managed in this application.

All accounts
Displays all managed accounts.

My Folder
Displays the user-defined folder and link to the account. You can add, rename and 
delete folders as you desire. The accounts displayed are links to accounts in All 
accounts. If you delete a link in My Folder, the corresponding account in All accounts is 
not deleted.

Note
If an account in All accounts is deleted, a link of the corresponding account in My Folder 
is deleted automatically.

Counter name The name of the page counter, such as Copy, Print, 
Scan, FAX (Send), FAX (Receive) and Media (if 
supported).

Size When Media is selected, the name of the media size is 
displayed.

Type Displays the type of the page counter, such as total, 
media size, color, or media type.

Counter value Displays the value of each counter.

Maximum output/
input

Displays maximum output/input of each counter. If 
Maximum output/input displays ‘-’, it is not 
configurable. If Maximum output/input displays ‘0’, this 
counter is not configured with a maximum output/input. 
The displayed value with ‘[ ]’ in Maximum output/input 
means that the value is applied to all counters in the 
account and not to an individual counter.
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Main list
Displays the printing systems relating to the account selected on the Tree. The Main list 
displays each printing system and the items below.

Sub list
Displays the page counter by function. When the connected printing system is a multi-
functional copier, function or media can be selected from the combo box on the upper 
right of sub list.

List style

Model name Displays the model name. Total displays the totals for 
each counter of each printing system.

IP address/Host name The IP address or the host name.

Copy and Print (Total) The sum of Copy (Total) pages and Print (Total) 
pages.

Copy (Total) The total copied pages.

Print (Total) The total printed pages.

Copy (Full color) The count of copied pages in full color.

Print (Full color) The count of printed pages in full color.

FAX (Send) The page count of the faxes sent.

FAX (Receive) The page count of the faxes received.

Scan (Total) The total scanned pages.

Scan (Copy) The count of scanned pages for copying.

Scan (Other) The count of scanned pages other than copying.

Copy (Mono color) The count of copied pages in mono color.

FAX (Send time) Total FAX send time in seconds.

Counter name The name of the page counter, such as Copy, Print, 
Scan, FAX (Send), FAX (Receive) and Media (if 
supported).

Size When Media is selected, the name of the media size is 
displayed.

Type Displays the type of the counter, such as total, media 
size and color, or media type.

Counter value Displays the value of each counter.

Maximum output/
input

Displays the maximum output/input of each counter. If 
Maximum output/input displays ‘-’, it is not 
configurable. If Maximum output/input displays ‘0’, this 
counter is not configured with a maximum output/input. 
The displayed value with ‘[ ]’ in Maximum output/input 
means that the value is applied to all the counters in the 
account, not to the individual counter.
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Graph style
The current page counter value is displayed in red and the maximum output/input value 
is displayed in blue.
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4. Menu
4.1. File Menu

The File menu allows you to import or export CSV and XML files. The printing system’s 
CSV file can register printing systems from one PC to another. The account CSV file 
can import settings for accounts and restrictions. The import settings for accounts are 
variables such as IP address, User ID, Account ID, Password, Maximum printing 
output/input for each function, etc. Import settings for restrictions are those settings that 
enable or disable job accounting for each function.

The database XML file can duplicate the database of this application from one PC to 
another. The following section describes how to use the File menu.

Import
This menu allows you to import the data of printing systems, accounts and database.

Import  Printing Systems
Registers printing systems from a CSV file to this application.

The format of the CSV file is shown below.

Note
Items 6 to 11 apply only to the printing system supporting the corresponding functions.

Column Item Description

1 IP address/Host name Specifies the IP address or the host name of 
the printing system.

2 Accounting Administrator 
Code

Specifies the accounting administrator code.

3 User ID Specifies the login user ID.

4 Password Specifies the login password.

5 Community name Specifies the community name.

6 Copy counter Allows you to limit copy count and print count 
together when applying the maximum output/
input. (1: include print count, 2: not include 
print count)

7 Enable/Disable Job 
Accounting

Allows you to enable/disable the accounting 
function by checking/un-checking the items. 
(1: on, 0: off)

8 Enable Copy based Job 
Accounting

Enables or disables the job accounting for 
copying. (1: on, 0: off)

9 Enable Printer based Job 
Accounting

Enables or disables the job accounting for 
printing. (1: on, 0: off)

10 Enable Scan based 
accounting

Enables or disables the job accounting for 
scanning. (1: on, 0: off)

11 Enable FAX based 
accounting

Enables or disables the job accounting for 
FAX. (1: on, 0: off)
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Import  Account
Account information including output/input restrictions, can be imported from an 
Account CSV file.

The format of the Account CSV file is as follows.

Column Item Description

1 IP address/Host name Specifies the IP address or the host name of 
the printing system. The printing system must 
be registered to this application.

2 Account ID Specifies the account ID to be added. The 
maximum length of account ID is 8 digit.

3 Account name Specifies the account name. This is omitted 
with unsupported printing systems. The 
maximum length of account name is 32 
characters.

4 Blank Blank

5 Account maximum output/
input

Specifies the maximum output/input for the 
whole account.

6 Maximum printing output/
input pages

Specifies the maximum printing output/input 
pages.

7 Enables maximum output/
input for printing

Enables or disables the job accounting for 
printing. (1: on, 0: off)

8 Maximum printing output/
input pages in full color

Specifies the maximum printing output/input 
pages in full color.

9 Enables maximum output/
input for printing (Full color)

Enables or disables the job accounting for 
printing in full color. (1: on, 0: off)

10 Maximum copying output/
input pages

Specifies the maximum copying output/input 
pages.

11 Enables maximum output/
input for copying

Enables or disables the job accounting for 
copying. (1: on, 0: off)

12 Maximum copying output/
input in mono color

Specifies the maximum copying output/input 
pages in mono color.

13 Enables maximum output/
input for copying (Mono 
color)

Enables or disables the job accounting for 
copying in mono color. (1: on, 0: off)

14 Maximum copying output/
input pages in full color

Specifies the maximum copying output/input 
pages in full color.

15 Enables maximum output/
input for copying (Full color)

Enables or disables the job accounting for 
copying in full color. (1: on, 0: off)

16 Maximum scanning output/
input

Specifies the maximum scanning output/input 
pages.

17 Maximum scanning other 
than for copying output/
input

Specifies a maximum scanning output/input 
other than for copying.
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Sample
192.168.1.1,0001,Account A,,100,100,1,100,1,100,1,100,1,100,1,100,100,1,100,1
192.168.1.2,0002,Account B

Note
Items 5 to 20 apply only to the printing systems that support the corresponding 
functions.

Import  Database
An XML file exported with the database contents can be imported. Importing the file 
deletes all existing information on the database and fills it with the contents of the file.

Export
This menu allows you to export the data of printing systems, counters, media type 
counters, media size counters, database and account ID list.

Note
Printing Systems and Database CSV files are available among the exported files when 
re-importing to KM-NET for Accounting.

Export  Printing Systems
Saves information of all printing systems, such as IP address/host name and account 
administrator code to a CSV file. While the exported file can be used in the Add 
Printing System Wizard, the contents of rows 6 to 9 tabulated below cannot be used in 
the imported file.  

Except for rows 1 to 5 in the table below, the contents and format of the exported 
printing system's CSV file differs from the import file.  

To import the exported CSV file, add or modify the contents to the exported file to meet 
the import file format. Delete the header item in the CSV file and add the necessary 
information in the rows after row 5, Community name.

The CSV format is shown below.

18 Enables maximum output/
input of the scanned other 
than for copying

Enables or disables the job accounting for 
scanning other than for copying. (1: on, 0: off)

19 FAX transmission output/
input

Specifies the maximum FAX transmission 
output/input.

20 Enables maximum output/
input for FAX transmission

Enables or disables the job accounting for fax. 
(1: on, 0: off)

Column Item Description

1 IP address/Host name The IP address or the host name of the 
printing system.

2 Accounting Administrator 
Code

The enciphered accounting administrator 
code.

3 User ID The login user ID.

4 Password The login password.

5 Community name The community name.

Column Item Description
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Export  Counter
Saves the names and counters of all printing systems to a CSV file. This file is for 
administration purposes only.

The CSV format is shown below.

Export  Media Type Counter
Saves the media type counter of the printing systems to a CSV file. This menu is only 
available for printing systems that support media type counter.

The CSV format is shown below.

6 Model name The model name.

7 Serial number The serial number.

8 Asset number The asset number.

9 Total printed pages The total printed pages.

Column Item Description

1 Printing system name The printing system name.

2 Account ID The account ID.

3 Account name The account name.

4 Copy and print (Total) The sum of Copy (Total) pages and Print 
(Total) pages.

5 Copy (Total) The total copied pages.

6 Print (Total) The total printed pages.

7 Copy (Full color) The count of copied pages in full color.

8 Print (Full color) The count of printed pages in full color.

9 FAX (Send) The page count of the faxes sent.

10 FAX (Receive) The page count of the faxes received.

11 Scan (Total) The total scanned pages.

12 Scan (Copy) The count of scanned pages for copying.

13 Scan (Other) The count of scanned pages other than for 
copying.

14 Copy (Mono color) The count of copied pages in mono color.

15 FAX (Send time) The total time of the FAX transmission in 
seconds.

16 Last updated The last update date and time.

Column Item Description

1 Printing system name The printing system name.

2 Account ID The account ID.

Column Item Description
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Export  Media Size Counter
Saves the media size counter of the printing systems to a CSV file. This menu is only 
available for the printing systems that support media size counter.

The CSV format is shown below.

Export  Database
Saves all information in the database to an XML file. The saved file can be imported.

Export  Account ID List
Saves account ID and name of all accounts to a CSV file. The Kyocera Extended 
Driver can import the file.

Exit
Quits the application.

3 Media ID The media ID.

4 Size The media size.

5 Type The media type.

6 Counter value The media type counter.

Column Item Description

1 Printing system name The printing system name.

2 Account ID The account ID.

3 and 
up

Media sizes and counter 
values

Media sizes and the related counter values.

Column Item Description
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4.2. Edit Menu
The Edit menu allows you to create and manage user-defined folders.The following 
section describes how to use the Edit menu.

Move to Folder
Creates a link to a printing system or an account link to a folder. Usually, a link can be 
created by dragging and dropping a printing system to any folder which the 
administrator has created under My Folder.  For example, drag and drop a printer icon 
from the All Printing Systems folder to the Sales folder inside My Folder. 

Add Folder
Creates a new folder.

Rename Folder
Renames the folder.

Delete Folder
Removes the folder. All folders and links that are included in the deleted folder are also 
deleted.

Delete Link
Removes the link. The corresponding printing system or account is not deleted.

Copy to Clipboard

Copy to Clipboard  Main list
The contents of the Main list are copied to the clipboard. Each item in a row is 
separated with tab code.

Copy to Clipboard  Sub list
The contents of the Sub list are copied to the clipboard. Each item in a row is separated 
with tab code.
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4.3. View Menu
The View menu allows you to configure views and rename printing systems and 
accounts. The following section describes how to use the View menu.

Configure Views
Configures the style of the tree and the sub list.

Tree
Changes the style of the tree to printing system-oriented or account-oriented.

Sub list
Changes the style of the sub list to list or graph style.

Configure the Printing System Name
Configures the name of the printing systems registered in this application.

Printing systems
Displays all printing systems registered to this application.

Printing system name
Enter the new printing system name. When left blank, the default name of the printing 
system is specified.

Configure the Account Name
Configures the name of the account managed in this application.

Accounts
Displays all accounts managed in this application.

Account name
Enter the new account name.

Toolbar

Displays the toolbar on the screen. The toolbar has buttons which execute the 
commonly-used functions. The toolbar is displayed by default.

Status Bar
Displays the status bar on the screen. The status bar displays the status of the selected 
printing system as well as the number of items on the Main list.

Main List (Details)
Displays details of the main list.
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4.4. Printing System Menu
The Printing System menu allows you to add and delete printing systems to this 
application and configure the account ID registered in the printing system. The following 
section describes how to use the Printing System menu.

Add
Starts the Add Printing System Wizard to add the printing systems. For details, refer 
to Registering the Printing System on page 6.

Delete
Deletes the selected printing system.

Configure Account
Configures the accounts in the selected printing system.

Available
Displays the accounts managed in this application.

Registered
Displays the accounts in the selected printing system.

To configure the accounts, select the desired account and click Add or Remove.

Update
Updates the property, accounting and counter information by retrieving the latest one 
from the printing system.

Configure Media Type
Configures up to five combinations of media size and media type to display in Media 
counters. This setting is available only for printing systems that supporting the media 
type counter.

Note
Duplicated combinations cannot be configured.

Edit Printing System Name
Configures the name of the selected printing system.
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Property
Confirms and configures the settings of the selected printing system.

Note
All items which cannot be configured and those not supported by the printing system 
are grayed out.

Model name The model name.

IP address/Host name The IP address or the host name.

Serial number The serial number of the printing system.

Community name The community name.

Number of accounts The total number of accounts.

Base unit of maximum 
output/ input

The base unit of maximum output/input. The maximum 
output/input is multiples of the base unit.

Available maximum 
output/input

The maximum output/input that is applied to the printing 
system.

Last updated The date and time at which the counter is updated.

Asset number The asset number of the printing system.

Accounting 
Administrator Code

Changes Accounting Administrator Code.

Print a report on illegal 
account

Determines whether an error report is printed when an 
account ID error has occurred.

Print a report on 
exceeded maximum 
output/input

Determines whether an error report is printed when the 
counter exceeds the maximum output/input.

Note
Depending on the printing system, this setting will be 
grayed out. The same setting as Print a report on 
illegal account is applied.

Cancel a job on illegal 
account

Allows you to configure whether or not to cancel an 
incoming job if there is an error reported on the Account 
ID.

Cancel a job on exceeded 
maximum output/input

Determines whether a job is canceled if the counter 
exceeded the maximum output/input.

Permit processing a job 
without account ID

Determines whether a job without an Account ID is 
permitted.

Copy counter Determines whether to limit print count and copy count 
together when applying the maximum output/input.
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4.5. Account Menu
The Account menu allows you to add and delete account IDs and configure the printing 
systems associated with the account IDs. The following section describes how to use 
the Account menu.

Add
Adds a new account to the printing system.

Account ID
Enter the new account ID. The maximum length of an account ID is 8 digits.

Account name
Enter the new account name. It is available only for the printing system supporting 
account names. The maximum length of an account name is 32 characters.

Delete
Deletes the selected account.

Note
If you delete an account from the tree in the Account View, the account is deleted from 
all related printing systems.

Configure Printing System
Configures the printing systems associated with the selected account.

Available
Displays printing systems available for registration.

Registered
Displays printing systems registered to the selected account.

Configure Output Permission
Configures the output permission of copying, printing, scanning and FAX. This setting is 
available only for printing systems supporting output permission.

Accounts
Displays the list of all accounts registered to the printing system.

Enable Job Accounting Enables job accounting function.

Enable Copy based Job 
Accounting

Enables job accounting for copying.

Enable Printer based Job 
Accounting

Enables job accounting for printing.

Enable Scan based Job 
Accounting

Enables job accounting for scanning.

Enable FAX based Job 
Accounting

Enables job accounting for FAX.
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Output permission
Check the output which is allowed using the account.

Note
Only the available outputs are displayed.

Property
Changes the name of the selected account.

Account ID
Displays the account ID.

Account name
Enter the new account name. The maximum length of an account name is 32 
characters.

4.6. Counter Menu
The Counter menu allows you to set the maximum output/input and reset the counter 
value. The following section describes how to use the Counter menu.

Set Maximum Output/Input
Configures the maximum output/input. When the value is 0, the maximum output/input 
is disabled.

Enable
Click on the checkbox to enable the maximum input/output configured.

Reset Value
Resets the counters.

Notes
• If you select All printing systems from the tree in the Printing System View and 

execute Reset Value, all the counters managed in this application are reset.

• If you select a printing system from the tree in the Printing System View and execute 
Reset Value, all the counters in the printing system are reset.

Set Warning Level
Selects the warning level of 60% or 80%. When the counter reaches the warning level, 
the counter name in the sub list is displayed in red.

Warn if count is 60% or more
Warns when the counter reaches 60% of the maximum output/input.

Warn if count is 80% or more
Warns when the counter reaches 80% of the maximum output/input.
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4.7. Tool Menu
The Tool menu allows you to configure the option settings. The following section 
describes how to use the Tool menu.

Option
Changes the administration and database password and configures the setting of 
polling and column.

Administrator Password
Changes the administrator password. If an administrator is logged onto the domain, a 
password is not required. 

Use Windows Domain authentication
Select the checkbox to login in to KM-NET for Accounting, without entering the 
administrator password.

Note
When changing the administrator password, click Change Password before clicking 
OK.

Database
Changes the database password and optimizes the database.

Notes
• While this application is running in the background, you cannot change the database 

password and optimize the database.

• When changing the database password, click Change Password before clicking OK.
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Polling
Enables polling and adjusts the interval.

Column
Configures the columns displayed in the main list.

4.8. Help Menu
The Help menu allows you to refer to the help pages, the version of this application and  
copyright information. The following section describes how to use the Help menu.

Contents
Displays Help.

About
Displays the version of this application and copyright.
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5. Troubleshooting
If trouble occurs when using Network Tool for Accounting, refer to the table below to 
diagnose the problem and resolve it.  If the trouble persists, contact your service 
representative or authorized service center.

Symptom Cause Remedy

The application does 
not start.

Your PC does not meet the 
system requirements.

Upgrade your PC. For details, refer 
to System Requirements.

Low or Out of memory. Close all unnecessary applications.

The application is already 
running.

Two instances of the application 
cannot be run simultaneously.

No printing system is 
discovered.

The printing system has been 
turned off.

Start searching after the printing
system has been turned on.

The printing system has been 
removed from the network.

Start searching after the printing
system has been connected to the
network.

The printing system is 
operating (in the process of 
printing documents).

Try to search for the printing system
again after operation is complete.

The TCP/IP settings on your 
PC are not configured 
properly.

Contact your network administrator.

Depending on the network 
router configuration, a printing 
system is undetectable.

In some rare cases, heavy 
network traffic may prevent 
this application from detecting 
the printing systems.

Try to search again later or contact
your network administrator.

The application fails to 
obtain the information of 
account or printing 
system.

The printing system has been 
turned off.

Turn the printing system on.

The printing system has been 
removed from the network.

Connect the printing system to the
network.

The printing system is 
operating, such as printing a 
document.

Try to obtain the information
again after operation is complete.

The application fails to 
add/delete accounts.

The printing system has been 
turned off.

Turn the printing system on.

The printing system has been 
removed from the network.

Connect the printing system to the
network.

The printing system is 
operating, such as printing a 
document.

Try to add/delete account again after 
operation is complete.

The printing system is in 
sleep mode.

Try to add/delete account again after 
releasing sleep mode.
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